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Workstation features
The features of an ergonomic workstation are highlighted in the diagram below. Some 
features of the workstation may vary depending on the type of computer work being 
performed. Graphic work may require the use of a pen tool, and multiple monitors are 
commonly used for a variety of digital work.

Top of screen The screen angle should be adjustable between 85 and 125 
degrees to the horizontal. 

Centre of screen Minimise screen reflection and glare by using an anti-glare filter.

Bottom of screen Place a document holder beneath or beside the screen at the 
same viewing distance as the screen.

Top line of sight The viewing distance should be between 400 mm and 700 mm.

Bottom line of sight A relaxed viewing angle is approximately 35 degrees.

Head Keep your head erect.

Shoulder Have your upper arms hanging freely.

Elbow Have your forearms approximately horizontal.

Above knee Ensure there is clearance between the lower edge of the desk and 
your legs.

Below knee Ensure there is clearance between the front edge of the seat and 
the lower leg.

Footrest Use a footrest if needed.

Back of chair The back support should be adjusted to support the small of your 
back.

Under chair Adjust the seat height to suit your furniture and equipment.

Chair legs Use a chair with a five castor base.
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Practise conservation techniques
Conserving resources at work benefits not only the 
organisation by reducing costs, but also the planet by 
reducing greenhouse gases and the amount of waste sent to 
landfill. Most organisations have policies and procedures 
for conserving resources. You can find out what these are by 
reading your workplace manual or asking your manager or 
colleagues.

Ways to conserve resources at work include:
• minimising paper wastage
• reducing energy use.

Minimise paper wastage
Wasting paper costs organisations and the planet a great deal. Consequently, many 
organisations have developed policies for paper usage. These include:
• using both sides of the paper when photocopying
• recycling non-confidential waste paper in recycling bins
• storing email messages in an electronic folder instead of printing
• reducing the volume of printing where possible
• reusing paper by using blank sides for rough drafts and reusing folders and files
• using recycled paper or paper from plantation timber for printed documents
• using a recycling service to collect waste paper.

1B	 Minimise wastage
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Spreadsheet layout
Before you start entering data you should be familiar with the layout of a spreadsheet.

A spreadsheet is a grid of columns and rows. It has numbers down the side and capital 
letters across the top. There are other items located above and below the grid. You will use 
these in every spreadsheet you create so it is important you understand what they are and 
how to use them. The items include: 
• Spreadsheet work area
• Title bar
• Ribbon
• The Formula Bar
• The active sheet

Spreadsheet work area
A spreadsheet is called a worksheet. Multiple 
spreadsheets are called a workbook. A spreadsheet 
is divided into columns and rows. The intersection 
of each column and row is called a cell. The current 
cell is shown by a highlighted rectangle. This is the 
cell that data can be entered into. To move to another 
cell, click into the required cell. Each cell has a name. 
The name is simply the letter above the cell and 
the number to its left. The cell name is called a cell 
reference, like a grid reference on a map.
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… continued

5. Repeat this process across the row and enter the text Expenses, Profit and Clear Profit into their
own cells (see illustration to guide you).

6. Click into cell A5 and enter text January.
7. You can enter the names for the rest of the months in two ways.

Type each month into its own cell as shown or you can use the Fill
function.

8. To use Fill, move the cursor over the little square in the bottom right-hand corner of the cell with
January in it. The cursor will form the shape of a small black cross.

9. While pressing the left mouse button, drag the small black
cross (Fill handle) down. You will begin to see the names of
other months appearing. Keep dragging until you reach the
cell that says December.

10. Release the button and Excel will automatically fill in the
months for you.

11. Enter the values as displayed in the example under the relevant headings Income and Expenses.
12. Save your worksheet in a suitable location on your hard drive and name it Amy’s Booksellers.

13. Select one of the numbers you have entered in the Income column. Click into the cell and re-type
the new number.

14. Save your changes and close your worksheet.
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Practice task 3
Read the case study, then answer the questions that follow.

Case study

Josh works as an administrative assistant in a large organisation. One of his duties is to create 
spreadsheets to his manager’s specifications. One day Josh is asked to create a spreadsheet 
containing the monthly sales figures of a selection of products the organisation sells. The 
spreadsheet has to calculate the total takings for each product and then work out a 10 per cent 
taxation charge for each amount calculated.
The spreadsheet must be formatted to organisational requirements and then saved to the 
server in the shared folder for sales. Josh’s manager tells him to name the spreadsheet Product 
Totals.
As well as entering the monthly sales figures in one column, Josh has to create two more 
columns of information.

1. Describe the information to be held in the two new columns.

2. Decide on names for the two new columns.

3. How does Josh have to format the data?

4. What is the name of the spreadsheet and where will it be stored?

continued …
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Practice task 4
Read the case study, then answer the questions that follow.

Case study

Helen has recently taken up a position as an administrative officer with a government 
department. Her manager has asked her to compile a spreadsheet report analysing the number 
of people who have travelled overseas in the past year, as well as information on countries 
visited. She has also been asked to ensure that she follows standard guidelines for producing 
the report such as colours, font type and size and the department logo. The report from the 
spreadsheet is to be distributed to media outlets. A graphical representation showing the top-
10 locations for travel is also required.

1. Who is the audience for the spreadsheet?

2. What is the purpose of the spreadsheet?

3. What are the information requirements?

4. What are the elements of spreadsheet design that Helen needs to consider?
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Practice task 6
1. Create the following spreadsheet and save it as a template named Monthly Consultant Sales

Report.

Practice using the template. Select the File tab, choose New, and select My Templates. The 
Monthly Consultant Sales Report template should be available for your use, as below.

Here are some of the features you can incorporate into your style sheets:
•• borders
•• page numbers
•• alignment
•• typeface styles and point size.

continued …



72  © Aspire Training & Consulting

BSBITU304
Produce spreadsheets

There are numerous techniques for improving the appearance of spreadsheets. Here are 
some examples of how formatting can change the appearance of a spreadsheet. Compare the 
two examples: the first has not been formatted and the second has.

Alignment on page 
When creating spreadsheets, it is best practice to begin your spreadsheet at the start of 
the spreadsheet in A1. What occurs, however, is that when you print the spreadsheet, the 
information begins at the upper left of the page. This is reasonable for presentation of a 
longer report but if it is a shorter report, the spreadsheet will seem to be crammed into one 
corner.  Look at the following example of page alignment:

3B	 Format a spreadsheet
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… continued

•• Press the Enter key to perform the calculation. Fill the calculation down the column.
•• Select F4, the first empty cell under End Profit. Enter the following formula =D4–E4. This

calculation subtracts Tax from Profit, giving you an End Profit value.

Use the following example to help you.

•• Press the Enter key to perform the calculation. Fill the calculation down the column.
•• Save your work.

3. Enter the following data into a new spreadsheet.

•• Calculate the January commission. Remember to use the cell references in your formulas and
not the actual numbers (so use B3 and not 34,050 for example).

•• Save the file as January sales commissions.
4. In this exercise you are going to use a function to calculate totals.

•• Open your Warehouse Profit spreadsheet. You are now going to use the SUM function to add
totals for each column of your worksheet that has a numeric value.

•• Select cell B10. From the Formulas tab select the Insert Function button . You will see 
the following Insert Function dialog box. Highlight SUM and click OK.

continued …
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… continued

Problem Example Action to take to correct 
the problem

Green error 
alert

•• Click on the green alert – a
message will appear to explain
the possible problem

•• Investigate error, and make
necessary corrections

•• Use the warning menu to make
appropriate choices

Investigation 
into possible 
errors in 
results 
needed

•• Use the Formula Auditing tools
to track the formula – this can
only be used if the formula has
been input using cell references
such as =A1+A2

Help resources you can use
Working with computer applications can be quite 
complex. There may be times when you need to seek 
assistance. Excel has a built-in help function, but if 
you cannot find the answer there you may need to 
seek the advice of an experienced Excel user.
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This learning checkpoint allows you to review your skills and knowledge in creating a 
spreadsheet.

Part A
Create the following two spreadsheet reports. Save them to an appropriate location and 
name them as shown. Use appropriate formulas and functions to create the summary 
figures. Use the various software functions to assist you to produce them. Use any help 
resources available to you as needed.

Learning checkpoint 3 
Create a spreadsheet
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Choose and design a chart
The kind of chart you choose and its design should 
reflect your organisation’s needs. In this section, you 
will look at different types of charts and consider 
some of their most appropriate uses.

Area chart
Area charts are used to demonstrate changes over 
time. For instance, they may be used to show and 
compare changes to sales over a given time. Area 
charts highlight total values across a time line. 

The following example shows how yearly real estate 
sales figures vary for different outlets.
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3-D pie chart
If you prefer the 3-D look for your pie chart, choose 3-D when making your chart selection.

Line chart
A line chart shows the movement of values in a data series using single or multiple lines. It is 
useful for showing how the values of a data series can change over a period of time. 

The following example uses a line chart to show rainfall in Melbourne and Sydney.
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To create charts in your spreadsheet, the first thing  
is to know what data you want to present. The second 
is to know what you want to do with it – the purpose 
of the chart. Then you can choose the most 
appropriate type of chart to use. The data to be 
presented in the chart is known as the data range. 
This information may include text and numeric data. 
The numeric data is what is represented in the chart 
and the text relates to the series (or group) of data.

Before you start to produce charts, become familiar 
with the terms used when referring to parts of 
a chart. 

The following information explains the meanings of 
terms you need to know.

Axes

An axis is a line that labels the 
information in a chart according to 
the labels in the columns and rows 
of your spreadsheet. Axes (the 
plural of axis) provide a reference 
for measurement or comparison of 
the data in the chart. Most charts 
have a vertical axis (known as 
the Y axis) and a horizontal axis 
(known as the X axis).

Categories

Categories are the names that are 
placed along the X axis of a chart 
and are determined by the labels 
in your spreadsheet.

Data range

The data range is the selection 
of values you choose from a 
worksheet to place in a chart; for 
example, all the numbers in one 
row or one column of data.

Legend

The legend is the key used to 
identify the various data series. If 
you include the series labels from 
your worksheet, Excel will add 
these to the legend. Otherwise the 
legend will display series 1, series 
2 and so on.

4B	 Create charts



© Aspire Training & Consulting 107

Topic 4
Produce simple charts

Practice task 12
Create a spreadsheet, with the data below for Hemline Miller, showing sales, customer numbers and 
quantities sold. 

1. Create a column chart that compares the sales data.
2. Create a scatter chart that compares customer numbers with quantity sold.
3. Create pie charts for sales, customer numbers and quantity sold.
4. Save your file as Hemline Miller January Report.
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Analysis tools
Use the Analysis tools to add a straight line to compare individual results to the average.

Background tools
Use the Background tools to format the plot area (right-click on area and select Format 
Plot Area).



© Aspire Training & Consulting 119

Topic 4
Produce simple charts

WordArt styling
WordArt Styles tools can be used to add effects to the labels within the chart.

Shape styling 
The Shape Styles group can be used to change the border image of objects in the chart.
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You must ensure you are producing quality spreadsheets and charts that adhere to 
organisational and task requirements. The final spreadsheet and chart must be thoroughly 
checked and proofed before completion to ensure the correct message and company image 
are delivered to the audience. Print previewing your spreadsheet and chart before printing 
can save time and ensure the necessary adjustments are made before you print.

When preparing spreadsheets and charts you must comply with the required time lines 
and job instructions. If you believe that either the time line or job instructions need to be 
altered, you should discuss this with your supervisor or the person who has requested the 
work. Many businesses have strict deadlines for completing tasks. Failing to meet deadlines 
can have an impact on other tasks and teams within the organisation. 

It is easier to access spreadsheets that have already been created by using appropriate file 
referencing and saving options. Saving files in the correct location is important as it ensures 
all interested parties can access the spreadsheet quickly and easily. It also saves time and 
improves on business efficiency.

In this topic you will learn how to:
5A	 Preview, adjust and print spreadsheets
5B	 Meet data input time lines and quality requirements
5C	 Name and store spreadsheets and exit applications safely
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Print the active worksheet
1. Open a spreadsheet file.

2. Go to the File tab and select Print.

3. From Page Setup select Scaling of 135 per cent. Scaling allows you to adjust the size of
the print-out, making it larger or smaller on the printed page.

4. The first drop-down menu under Settings identifies what is to be printed and will show
active sheets. From the drop-down menu you can choose to print the entire workbook
or a selection of cells. Alter the printer that you are printing to if needed, and select how
many copies you want to print. It is also possible to alter how the multiple printed copies
are collated. When you are ready to print, click the Print button.


